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BASS ist das Acronym für Basic Astronomical Spectroscopy Software und wurde von John Paraskeva 
entwickelt. Als freie Microsoft Windows basierte Anwendung ermöglicht BASS die vollständige Reduktion, 
Kalibrierung und eine weitgehende Auswertung von Spektren. 
  
https://groups.io/g/BassSpectro 
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Kalibrierung eines 200L/mm-DADOS-Spektrums des Sterns Sirius A ( CMa, A1V) 

mit der Energiesparlampe ESL Megaman/Ormalight 

1. Der vorliegende Datensatz: Sirius- und Referenzspektrum 
 

Der Datensatz: 10 Aufnahmen von Sirius und einer Aufnahme des Referenzspektrums, jeweils 3s belichtet. Die 

Spektren wurden mit dem DADOS Spaltspektrografen aufgenommen. Das Gitter mit 200 L/mm ermöglichst 

bei einer Kamerasensorbreite von ca. 18mm die Aufnahme des kompletten sichtbaren Spektrums 

von 3500Å bis in den Infrarotbereich ca. 10000Å. 

 

Das Referenzspektrum wurde mit der im Handel nicht mehr erhältlichen Energiesparlampe ESL Ormalight 

gewonnen, im Spektrum identisch mit der Lampe https://www.amazon.de/Megaman-R50-COMPACT-

REFLECTOR-Reflektor/dp/B0013QUF9Q/ref=sr_1_2?srs=1687663031&ie=UTF8&qid=1506502790&sr=8-

2&keywords=9w.  

Zur Aufnahme des Referenzspektrums strahlte die Lampe von vorne durch das Teleskop. 

Folgendes ist bei der Aufnahme grundsätzlich zu beachten. 

1. Referenzspektren und Objektspektren müssen zeitlich nah beieinander aufgenommen 

werden. Grund: Der Spektrograf dehnt sich aus oder zieht sich zusammen, wenn sich die 

Außentemperatur ändert. Deshalb lässt man den DADOS und das Teleskop zunächst eine 

halbe Stunde auskühlen, bevor man beginnt. Zuerst wird ein Referenzspektrum 

aufgenommen, dann eine Serie von Objektspektren und zum Schluss wieder ein 

Referenzspektrum. Ausnahme: Im vorliegenden Fall wurde nur ein Referenzspektrum 

aufgenommen. Im niedrigauflösenden Anwendungsbereich ist das auch völlig 

ausreichend, weil thermische Driften in der vorliegenden Serie nicht zu erkennen sind. 

Außerdem sollte der Spektralfaden möglichst exakt horizontal orientiert sein, blaues Ende links, rotes rechts. 
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Kalibrierung eines 200L/mm-DADOS-Spektrums des Sterns Sirius A ( CMa, A1V) 

mit der Energiesparlampe ESL Megaman/Ormalight 

2. BASS starten 
 

Dieses Tutorial setzt voraus, dass Rohspektren im Ordner C:/astrobodger/Sirius_ESL/…. im Format FIT 

vorliegen. Diese wurden im Rahmen des DADOS-Workshops 2017 an einem Celestron 11 EdgeHD-Teleskop 

mit MaxIm DL aufgenommen und bei der Aufnahme mit automatischen Darkframes korrigiert. Das 

Siriusspektrum wurde mit dem mittleren 25m-Spalt aufgenommen. 

 

Start der aktuellen Version BASSProject.exe im Ordner C:\astroboger 

 

Das leere Arbeitsfenster eines neuen Projekts: 

 

BASS arbeitet mit sogenannten „Projekten“, bei denen alle verwendeten 2D-Rohspektren, Ergebnisse und 

Beschriftungen gespeichert werden an einem festen Speicherort, C:/astrobodger. Projekte werden im Format 

.bass abgespeichert. BASS meldet sich, wenn Teile des Projekts (neue oder geänderte Spektralprofile) noch 

nicht gespeichert wurden und fordert dann dazu auf. Änderungen an vorhandenen oder neu erzeugte 

Spektralprofile werden im Format .fit (bzw. .dat) abgespeichert. Das FITS-Format ist umfangreicher als das 

DAT-Format, weil zusätzlich zu den Datenzeilen x,y auch alle wichtigen sonstigen Informationen gespeichert 

werden: Datum, Uhrzeit, Belichtungszeit, Aufnahmeort, etc.  

Hinweis: Der Begriff „2D“ bedeutet in der Spektroskopie, dass es sich um ein Foto des Spektrums handelt, so 

wie man es am Teleksop aufnimmt. „1D“ ist der aus dem Foto erzeugte Spektralprofil, welches nur ein 

Datensatz mit zwei Spalten ist: x =Position entlang des Sensors, y=Intensität in y-Richtung aufsummiert.  
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Kalibrierung eines 200L/mm-DADOS-Spektrums des Sterns Sirius A ( CMa, A1V) 

mit der Energiesparlampe ESL Megaman/Ormalight 

2. Spektren stacken 
 

➔ Stack Images 

 

 

 

 

 

 

 

 

 

 

➔ Erstes Bild Sirius-001.fit anwählen  

➔ [no alignment]: Es gibt keine erkennbaren Verschiebungen in x-Richtung. Bitte kein Alignment in Y-

Richtung vornehmen, weil die Spektren zum Referenzspektrum passen müssen. 

➔ Clear alignment points: Sicherheitshalber alte „Points“ löschen. 

➔ Alles andere nicht aktivieren 

➔ Stack 
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Kalibrierung eines 200L/mm-DADOS-Spektrums des Sterns Sirius A ( CMa, A1V) 

mit der Energiesparlampe ESL Megaman/Ormalight 

Das Ergebnis: Ein Summenbild von 10 Einzelspektren.  

 

➔ Image Strip View -> Raw Image 25% oder 50% 

 

 

 

 

 

 

 

 

Erläuterung: Die x-Achse („Pixels uncalibrated“) entspricht der Pixelposition in horizontaler x-Richtung auf dem 

Foto. Dieser Pixelwert muss in einen Wert für die Wellenlänge  (Lambda) umgerechnet werden. Diesen 

Vorgang bezeichnet man als Wellenlängenkalibrierung. 

Die y-Achse („Flux“) gibt die Intensität an einer bestimmten Pixelposition im 1D-Spektralprofil an. Diese 

Intensitätskurve wird auf zwei Arten kalibriert:  

a) Beseitigung des Pseudokontinuums (Normierung auf „1“).  

b) Absolutkalibrierung ( = Flusskalibrierung) mit Hilfe eines Referenzspektrums.   
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Kalibrierung eines 200L/mm-DADOS-Spektrums des Sterns Sirius A ( CMa, A1V) 

mit der Energiesparlampe ESL Megaman/Ormalight 

4. Voreinstellungen vornehmen 
 

➔ Project Chart Settings: Hier alle Daten eingeben.  

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

➔ Titel jeweils speichern 

Chart width: CFG Medion-Notebooks ca. 1150 / Chart height: 450 (hängt von der Größe des Bildschirms ab) 
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Kalibrierung eines 200L/mm-DADOS-Spektrums des Sterns Sirius A ( CMa, A1V) 

mit der Energiesparlampe ESL Megaman/Ormalight 

 

 

Chart width: CFG Medion-Notebooks ca. 1150 / Chart height: 450 (hängt von der Größe des Bildschirms ab) 

 

… und am Ende das Anwendden und Speichern nicht vergessen → Apply → Ok 
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Kalibrierung eines 200L/mm-DADOS-Spektrums des Sterns Sirius A ( CMa, A1V) 

mit der Energiesparlampe ESL Megaman/Ormalight 

 

➔  Speichern des gestackten Bildes: C:/astrobodger/Sirius_ESL/Sirius.fit 
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Kalibrierung eines 200L/mm-DADOS-Spektrums des Sterns Sirius A ( CMa, A1V) 

mit der Energiesparlampe ESL Megaman/Ormalight 

➔   Speichern des Projekts unter dem Namen C:/astrobodger/Sirius_ESL/Sirius/Sirius.bass 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

➔ Prüfen, ob Projekt korrekt gespeichert ist: New Projekt  → Open Project   
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Kalibrierung eines 200L/mm-DADOS-Spektrums des Sterns Sirius A ( CMa, A1V) 

mit der Energiesparlampe ESL Megaman/Ormalight 

5. Referenzspektrum öffnen 
 

➔ Open Image Files    

➔ Referenz.fit 

 

 

 

 

 

 

 

 

 

 

                                        

        #01 (Blau): Siriusspektrum, #02 (Grün): Referenzspektrum der ESL Megaman, identisch mit Ormalight 
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Kalibrierung eines 200L/mm-DADOS-Spektrums des Sterns Sirius A ( CMa, A1V) 

mit der Energiesparlampe ESL Megaman/Ormalight 

 

Jetzt Positionen tauschen: Das Referenzspektrum muss an Position 1 stehen. 

 

➔ #02 aktivieren -> Sequence -> 01 

 

 

Nach dem Tausch der Position ist dies die neue Reihenfolge:  
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Kalibrierung eines 200L/mm-DADOS-Spektrums des Sterns Sirius A ( CMa, A1V) 

mit der Energiesparlampe ESL Megaman/Ormalight 

5.  Siriusspektrum und Referenzspektrum horizontal ausrichten. 
 

➔ Spektrum 02 Sirius aktivieren 

➔ Image → Rotate/Tilt correction 

 

 

 

 

 

 

 

 

 

 

➔ Select Option → Draw Angle und Rotate Image wählen. 

➔ Dann mit der Maus eine Line entlang des Spektrums ziehen. 

➔ Apply 

➔ Close 
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Kalibrierung eines 200L/mm-DADOS-Spektrums des Sterns Sirius A ( CMa, A1V) 

mit der Energiesparlampe ESL Megaman/Ormalight 

Nun sind beide Spektren gleichermaßen horizontal ausgerichtet. Hinweis: Im Falle geneigter oder gebogener 

Spektrallinien muss die Funktion Tilt Image bzw. Horizontal Smile ausgeführt werden. Zwar sind die 

Referenzlinien im vorliegenden Spektrum leicht geneigt, doch dies wirkt sich auf das sehr schmale Spektrum 

nicht aus. Bei einem hochaufgelösten Spektrum würden man die Neigung ggf. korrigieren.  

➔ Abspeichern der soeben gedrehten beiden Spektren: Save the selected image strip (selbe Namen)  

 
 

 
 

 

➔ Speichern des Projekts:  unter dem selben Namen Sirius.bass 

 

  

http://www.schuelerlabor-astronomie.de/
mailto:Bernd.Koch@astrofoto.de


 

            
 Schülerlabor Astronomie des Carl-Fuhlrott-Gymnasiums, Jung-Stilling-Weg 45, 42349 Wuppertal 
www.schuelerlabor-astronomie.de | Kontakt: Dipl.-Phys. Bernd Koch | Bernd.Koch@astrofoto.de              14 

 

 
Kalibrierung eines 200L/mm-DADOS-Spektrums des Sterns Sirius A ( CMa, A1V) 

mit der Energiesparlampe ESL Megaman/Ormalight 

6. Spektralbereich eingrenzen -> Crop X-Axis Range 
 

➔ Mit der linken Maustaste einen Bereich aufziehen von x=700px bis zum rechten Rand 

  prüfen mit Apply, dann -> Close -> Ok ➔    

➔ Name des Profils Nr. 2 ändern: StacK10Images -> Sirius 

➔ Projekt speichern 

7. Auswahl des Scanbereichs für Spektrum und Himmelshintergrund  (Region 

Selection Tool) 
➔ Spektrum #02 auswählen 

➔ Image Strip View: 100% 

➔ Selection → Region Selection Tool  

 

 

Es erscheint das Menüfenster Region 

Selection Tool. 

➔ Active Binned Region 

(Sternspektrum definieren) 

➔ Ziehe nun einen Rahmen innerhalb 

des Spektrums auf 

 

 

 

 

 

 

 

 

 

 

(Rahmen aufziehen) 
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Kalibrierung eines 200L/mm-DADOS-Spektrums des Sterns Sirius A ( CMa, A1V) 

mit der Energiesparlampe ESL Megaman/Ormalight 

 

➔ Verändere die Werte für Y Start und Y End, bis der Rahmen das Spektrum in nahezu voller Höhe 

umfasst. Die Breite wird automatisch angepasst. 

➔ Update 

Nun wird der Himmelshintergrund definiert, der später subtrahiert werden soll: 

➔ Substraction Region 1 (für Himmel „oben“, also oberhalb des Siriusspektrums) 

➔ Rahmen aufziehen für Himmel „oben“ 
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Kalibrierung eines 200L/mm-DADOS-Spektrums des Sterns Sirius A ( CMa, A1V) 

mit der Energiesparlampe ESL Megaman/Ormalight 

➔ Update 

➔ Substraction Region 2 (Himmel „unten“, also unterhalb des Siriusspektrums) 

➔ Rahmen aufziehen für Himmel „unten“ 

➔  

 

 

 

 

 

 

 

 

 

 

 

 

 

 

➔ Update 

➔ Close 

 

Und das ist das Ergebnis der Festlegung der Bereiche: 

 

 

 

 

 

 

 

http://www.schuelerlabor-astronomie.de/
mailto:Bernd.Koch@astrofoto.de


 

            
 Schülerlabor Astronomie des Carl-Fuhlrott-Gymnasiums, Jung-Stilling-Weg 45, 42349 Wuppertal 
www.schuelerlabor-astronomie.de | Kontakt: Dipl.-Phys. Bernd Koch | Bernd.Koch@astrofoto.de              17 

 

 
Kalibrierung eines 200L/mm-DADOS-Spektrums des Sterns Sirius A ( CMa, A1V) 

mit der Energiesparlampe ESL Megaman/Ormalight 

Zurück zur Gesamtansicht: 

 

 

Nun wird die „Active Binning Zone“, also der Bereich des Siriusspektrums, der gescannt wird, auf das 

Referenzspektrum übertragen: 

➔ Mit rechter Maustaste in das Spektrum 01 Referenz.fit klicken 

➔ Copy Active Binned Region from 

➔ 02 Stack10Images (Siriusspektrum) 
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Kalibrierung eines 200L/mm-DADOS-Spektrums des Sterns Sirius A ( CMa, A1V) 

mit der Energiesparlampe ESL Megaman/Ormalight 

Ergebnis: Es sind alle benötigten Bereiche in beiden Spektren definiert:  

 

 

➔ Speichern des Projekts unter dem selben Namen Sirius.bass 

 

In der Bildbeschriftung nun die Namensänderung vornehmen:  

➔ Spektrum 2 aktivieren mit Mausklick 

 

➔ Profile Properties: 02 Stack 10Images   

➔ Neue Caption: Sirius 
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Kalibrierung eines 200L/mm-DADOS-Spektrums des Sterns Sirius A ( CMa, A1V) 

mit der Energiesparlampe ESL Megaman/Ormalight 

8. Wellenlängenkalibrierung des Referenzspektrums 
 

Dies sind die hier verwendeten Referenzlinien, außer 7605Å. 

➔ 01: Referenz.fit aktivieren 

➔ Enter Line Calibration Mode                             

➔ Erste Referenzline eng eingrenzen:4046.565Å 

➔ Element filter: ESL 

➔ ESL Hg I – 4046.565 wählen 
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Kalibrierung eines 200L/mm-DADOS-Spektrums des Sterns Sirius A ( CMa, A1V) 

mit der Energiesparlampe ESL Megaman/Ormalight 

 

➔ Add Another Point 

 

 

 

 

 

 

 

 

➔ Zweite Referenzline eng eingrenzen: 4358.335Å 

➔ ESL Hg I – 4358.335 wählen 
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Kalibrierung eines 200L/mm-DADOS-Spektrums des Sterns Sirius A ( CMa, A1V) 

mit der Energiesparlampe ESL Megaman/Ormalight 

 

➔ Add Another Point 

 

 

 

 

 

 

 

 

 

➔ Dritte Referenzline eng eingrenzen: 5460.74Å 

➔ ESL Hg I – 5460.74 wählen 
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Kalibrierung eines 200L/mm-DADOS-Spektrums des Sterns Sirius A ( CMa, A1V) 

mit der Energiesparlampe ESL Megaman/Ormalight 

 

➔ Add Another Point 

 

 

 

 

 

 

 

 

 

 

➔ Vierte Referenzline eng eingrenzen: 6311Å 

➔ Suggest schläge ESL EuY2O3-6311 vor 

➔ Calibration fit umstellen auf 2 Quadratic (Polynom zweiten Grades). Restfehler: 0.968Å 
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Kalibrierung eines 200L/mm-DADOS-Spektrums des Sterns Sirius A ( CMa, A1V) 

mit der Energiesparlampe ESL Megaman/Ormalight 

 

➔ Add Another Point 

 

 

 

 

 

 

 

 

 

 

 

 

 

➔ Fünfte Referenzline eng eingrenzen: 7123Å 

➔ Suggest schläge ESL EuY2O3-7123 vor 

➔ Calibration fit umstellen auf 3 Cubic (Polynom dritten Grades). Restfehler: 0.626Å  

➔ Mit der fünften Linie des Referenzspektrums endet die Eingabe 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

➔ Finish 
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Kalibrierung eines 200L/mm-DADOS-Spektrums des Sterns Sirius A ( CMa, A1V) 

mit der Energiesparlampe ESL Megaman/Ormalight 

Übertragung der Kalibrierung von 01 Referenzspektrum auf das Spektrum 02: Sirius 

 

➔ 02 Sirius anwählen 

 

➔ Profile properties 02 Sirius 

➔ Use Calibration from first profile 

➔ Copy 

➔ OK  

 

 

Die Koeffizienten wurden übertragen: 
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Kalibrierung eines 200L/mm-DADOS-Spektrums des Sterns Sirius A ( CMa, A1V) 

mit der Energiesparlampe ESL Megaman/Ormalight 

 

 

 

➔ Image Strip View umstellen auf Synth Color stretched (synthetisches Sternspektrum) 

➔ Speichern des Projekts unter dem selben Namen Sirius.bass 

 

➔ Show/Hide Calibration Points: Schaltet die Anzeige der Kalibrierpunkte ein und aus! 

 

 

 

 

 

 

 

➔ Ausblenden des Referenzspektrums:  
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Kalibrierung eines 200L/mm-DADOS-Spektrums des Sterns Sirius A ( CMa, A1V) 

mit der Energiesparlampe ESL Megaman/Ormalight 

➔ Spektrum #02 Sirius mit der Maus aktivieren: 

 

Einblenden der Balmerserie des Wasserstoffs: 

 

➔ Measurements and Element 

Lines 
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Kalibrierung eines 200L/mm-DADOS-Spektrums des Sterns Sirius A ( CMa, A1V) 

mit der Energiesparlampe ESL Megaman/Ormalight 

9. Kalibrierung der Intensität des Spektrums 
 

Der Intensitätsverlauf des wellenlängenkalibrierten Spektrums stellt nicht den wahren Kontinuumsverlauf dar. 

Dieser wird durch verschiedene Faktoren verfälscht. Dazu zählt die Instrumentenfunktion („Response“) von 

Teleskop, Spektrograf und Kamera, sowie Absorption und Streuung an interstellarem Staub und Molekülen in 

der Erdatmosphäre. Zusammengefasst spricht man von einem Pseudokontinuum.  

Auf zwei verschiedene Arten können diese Einflüsse beseitigt werden: Normierung auf „1“ oder 

Flusskalibrierung. 

9.1 Normierung des Spektrums 
 

Unter der Normierung eines Spektrums versteht man die Eliminierung des pseudokontinuierlichen Anteils im 

Spektrum, so dass nur noch die Spektrallinien im Spektrum verbleiben.  

Subtraktion des Kontinuums: Hat den Nachteil, dass bei einer Subtraktion die relativen Intensitäten der 

Spektrallinien zueinander nicht stimmen. Wird in der Regel nicht angewendet. 

Division durch das Kontinuum: Die relativen Intensitäten bleiben erhalten, das Divisionsergebnis ergibt im 

Spektrum im Idealfall einen exakt horizontalen Verlauf, dessen Intensität den Wert „1“ aufweist. Deshalb 

spricht man auch von der Normierung auf „1“. Dies wird im Folgenden beschrieben. 

Durchführung einer Normierung: 

➔ Spektrum 02: Sirius aktivieren 

➔ Continuum and Response Shaper anwenden auf  

02 Sirius.fit 

 

 

 

 

 

 

➔ Kästchen setzen per Doppelklick entlang des Kontinuums. Refresh 

aktualisiert das Bild. Kästchen löschen mit mittlerer Maustaste. 

Spektrallinien überbrücken, ohne die Flügel der Linien zu kappen. Die so 

definierte orangene Kurve ist die sogenannte Instrumentenfunktion, meist 

auch als Response 

bezeichnet.  
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Kalibrierung eines 200L/mm-DADOS-Spektrums des Sterns Sirius A ( CMa, A1V) 

mit der Energiesparlampe ESL Megaman/Ormalight 

 

Die orangene Kurve ist die Instrumentenfunktion (Response) 

 

➔ Save as Continuum Removal for: 01 Sonne.fit 

 

➔ Normierung direkt anwenden: Abfrage mit Ok beantworten 
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Kalibrierung eines 200L/mm-DADOS-Spektrums des Sterns Sirius A ( CMa, A1V) 

mit der Energiesparlampe ESL Megaman/Ormalight 

 

 

 

 

 

 

 

 

 

Ergebnis: Normiertes Spektrum. Starkes Hintergrundrauschen unter 3700Å. 

 

➔ Wellenlängenbereich eingrenzen mit der Maus von ca. 3750Å bis 9000Å 
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Kalibrierung eines 200L/mm-DADOS-Spektrums des Sterns Sirius A ( CMa, A1V) 

mit der Energiesparlampe ESL Megaman/Ormalight 

 

 

 

➔ Falls das durchschnittliche Kontinuum NICHT auf einer horizontalen Linie liegt, kann die Datei 

response_norm.dat nochmals editiert werden. 

➔ Edit 
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Kalibrierung eines 200L/mm-DADOS-Spektrums des Sterns Sirius A ( CMa, A1V) 

mit der Energiesparlampe ESL Megaman/Ormalight 

➔ Target Profile: 02 Sirius, 

Free Draw 

➔ Neue Kästchen können 

gesetzt und/oder alte 

entfernt werden 

 

 

 

 

 

 

 

 

 

 

 

➔ Save  

 

 

➔ Ok 

 

Ergebnis: Ein normiertes Spektrum mit (nahezu) horizontalem Kontinuum. Die „Überschwinger“ unter 3700Å 

beruhen darauf, dass bei der auf fast Null abfallenden Intensität der Kontinuumsverlauf nur schwierig mit dem 

Setzen von Kästchen zu definieren ist. 
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Kalibrierung eines 200L/mm-DADOS-Spektrums des Sterns Sirius A ( CMa, A1V) 

mit der Energiesparlampe ESL Megaman/Ormalight 

 

➔ Projekt zwischendurch immer mal speichern:  Sirius.bass 

 

➔ Ansicht Vorher/Nachher: Wie sieht das Profil mit bzw. ohne Kontinummsbeseitigung aus?  

 

➔ Profile Properties  

➔ Response 

➔ Continuum Removal <->  

➔ No Response Correction 

hin- und her schalten 

 

 

 

 

 

 

 

 

 

 

 

9.1.1 Normierung auf „1“ 
„Normierung auf 1“ bedeutet, dass das Kontinuum auf den Wert 1 festgelegt wird. Die rote Linie wurde hier 

in dem Bild per Hand eingezogen, um zu zeigen, wo ungefähr das Intensitätsniveau 1 liegen soll. 
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Kalibrierung eines 200L/mm-DADOS-Spektrums des Sterns Sirius A ( CMa, A1V) 

mit der Energiesparlampe ESL Megaman/Ormalight 

Spektrum 02 Srius.fit an die erste Position setzen  

➔ Mit rechter Maustaste in das Sirusspektrum klicken 

➔ Sequence 

➔ 01 auswählen 

 

 

 

Unerwünschte Bereiche links und rechts des Spektrums ausgegrenzen. Ein vollständiges Abschneiden ist 

ist dieser späten Phase aber nicht mehr möglich! 

➔ Mit der linken Maustaste das Spektrum wie gewünscht eingrenzen 

 

 

 

➔ Crop X-Axis Range  

 

➔ Wellenlängenwerte ggf. anpassen 

➔ Apply 

➔ Ok 

 

➔ File -> Save Project File 
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Kalibrierung eines 200L/mm-DADOS-Spektrums des Sterns Sirius A ( CMa, A1V) 

mit der Energiesparlampe ESL Megaman/Ormalight 

 

Normierung auf „1“ durchführen: 

 

➔ Image  

➔ Normalize Flux Scale 

➔ Spektrum dahingehend sichten, dass man einen Bereich definieren kann, der den Wert 1 erreichen soll. 

Hier ca. 6000Å-6100Å 

➔ Falls unzufrieden mit der Lage der „1“-Linie, neue Start- oder Endwerte eingeben und Apply drücken. 

➔ Falls zufrieden -> Close 

 

 

 

Die Normierung passt nicht perfekt im UV-Bereich unter 3700Å. Der Grund liegt in der sehr geringen Intensität, 

die das Setzen der Kästchen beim Normieren erschwert. Das kann man verbessern, indem man die Response-

Datei editiert und neue Kästchen für das Kontinuum setzt. Für unsere Zwecke ist die Normierung jedoch 

ausreichend gut. 

Hinweis: Die Normierung auf „1“ ist ein höchst subjektiver Vorgang, der von jedem Bearbeiter mit einem 

anderen Ergebnis durchgeführt und beurteilt wird.  
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Kalibrierung eines 200L/mm-DADOS-Spektrums des Sterns Sirius A ( CMa, A1V) 

mit der Energiesparlampe ESL Megaman/Ormalight 

 

Manuelle Skalierung der Y-Achse (Flux) von 0 bis 1.2:  

 

➔    

 

 

 

 

 

 

 

 

➔ Save Property Settings 

➔ Ok 
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Kalibrierung eines 200L/mm-DADOS-Spektrums des Sterns Sirius A ( CMa, A1V) 

mit der Energiesparlampe ESL Megaman/Ormalight 

Ergebnis: Das auf „1“ normierte Sonnenspektrum, in der Intensität von 0 bis 1.2 skaliert. 

 

9.1.2 Beschriftung des normierten Spektrums 
 

➔ Add Label to chart -> Manage Labels -> Load Set 

➔ Labelset Sirius A1V.lbl öffnen 
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Kalibrierung eines 200L/mm-DADOS-Spektrums des Sterns Sirius A ( CMa, A1V) 

mit der Energiesparlampe ESL Megaman/Ormalight 

Das Labelset Sirius A1V ist vom Autor in dieser Stufe mit 13 Linien bestückt worden. Das Set kann editiert und 

mit weiteren Einträgen ergänzt werden. Die Datei liegt als Text-Datei im Ordner c:/astrododger/Reference  

 

 

Beispiel: Neues Label im Hochformat hinzufügen 

➔    
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Kalibrierung eines 200L/mm-DADOS-Spektrums des Sterns Sirius A ( CMa, A1V) 

mit der Energiesparlampe ESL Megaman/Ormalight 

 

➔ Rahmen unter der nächsten Linie aufziehen 

 

➔ Beispiel: H8 3889.064 eingeben. Hinweis: Das Zeichen Å findet 

man unter  „Linke ALT-Taste  0197“.  

 

➔ Hinweis: „ Wavelength“ ist nur die Position der Beschriftung 

im Spektrum. Hat nichts mit der realen Wellenlänge zu tun. 

 

 

➔ Speichern. 

 

 

 

 

 

 

Ergebnis: Ein an den Absorptionslinien mit Labels beschriftetes Spektrum: 

 

➔ File -> Save Project File Sirius.bass 
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Kalibrierung eines 200L/mm-DADOS-Spektrums des Sterns Sirius A ( CMa, A1V) 

mit der Energiesparlampe ESL Megaman/Ormalight 

 

Notizen erstellen und einblenden:  
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Kalibrierung eines 200L/mm-DADOS-Spektrums des Sterns Sirius A ( CMa, A1V) 

mit der Energiesparlampe ESL Megaman/Ormalight 

9.1.3 Speichern: Projekt – Profil – Chart – Image Strips 

➔ Speichern des Projekts mit allen Skalierungen und Beschriftungen:   Sirius.bass 

 

➔ Speichern des Spektralprofils (_1D), um es bsp. in VisualSpec oder MIDAS zu verarbeiten:  

(Sirius_1D.fits) 

 

 

 

 

 

 

 

➔ Speichern des synthetischen Spektrums von Sirius und der ESL zusammen unter Sirius.png 
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Kalibrierung eines 200L/mm-DADOS-Spektrums des Sterns Sirius A ( CMa, A1V) 

mit der Energiesparlampe ESL Megaman/Ormalight 

  

➔
Sc

re
en

sh
o

t 
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Kalibrierung eines 200L/mm-DADOS-Spektrums des Sterns Sirius A ( CMa, A1V) 

mit der Energiesparlampe ESL Megaman/Ormalight 

  

➔
C

h
ar

t 
 

➔
Sa

ve
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h
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t 
to

 F
ile
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Kalibrierung eines 200L/mm-DADOS-Spektrums des Sterns Sirius A ( CMa, A1V) 

mit der Energiesparlampe ESL Megaman/Ormalight 

Ein farbiges Spektralband im Hintergrund erzeugen 

➔ Background colour 

➔ Wavelength Colour blend 

 

 

 

 

 

 

 

 

 

 

 

 

 

➔ Screenshot  
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Kalibrierung eines 200L/mm-DADOS-Spektrums des Sterns Sirius A ( CMa, A1V) 

mit der Energiesparlampe ESL Megaman/Ormalight 

9.2 Flusskalibrierung mit einem kalibrierten Referenzstern 
 

Unter dem Begriff der Flusskalibrierung versteht man eine Intensitätskalibrierung, die die relative Intensität 

bei der jeweiligen Wellenlänge korrekt wiedergibt. Relativ auf das Maximum bezogen, nicht in absoluten 

physikalischen Einheiten. 

➔ Open BASS project file or bundle 

➔ Sirius_flusskalibriert.bass ist eine Kopie der bisherigen wellenlängenkalibrierten Datei. 

 

Wir laden als Ausgangspektrum dieses wellenlängenkalibrierte, jedoch nicht intensitätskalibrierte Spektrum: 
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Kalibrierung eines 200L/mm-DADOS-Spektrums des Sterns Sirius A ( CMa, A1V) 

mit der Energiesparlampe ESL Megaman/Ormalight 

9.2.1 Öffnen eines flusskalibrierten Referenzspektrums (Pickles-Datenbank) 
 

Um die Intensität absolut kalibrieren zu können, ziehen wir ein bereits flusskalibriertes Spektrum eines Sterns 

heran. Aber nicht ein beliebiges, sondern eines von einem Stern desselben Spektraltyps wie Sirius, A1V. 

➔ Tools 

➔ Reference Spectrum 

 

 

➔ Pickles-Datenbank. Wähle a0v. (Es gibt hier kein A1-Spektrum!). Wir nehmen es dennoch, weil es 

weiter in den IR-Bereich reicht als das MILES-Spektrum.  

 

➔ Add Spectrum to chart 

➔ Close 
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Kalibrierung eines 200L/mm-DADOS-Spektrums des Sterns Sirius A ( CMa, A1V) 

mit der Energiesparlampe ESL Megaman/Ormalight 

 

Das hier grün dargestellte Spektrum #03 ist ein vollständig flusskalibriertes Spektrum aus der PICKLES-

Datenbank, aus dem die auf Absorption in der Erdatmosphäre beruhenden tellurischen Linien/Banden des 

Sauerstoffs und Wasserdampfs bereits entfernt worden sind.  

 

Skalierung der Y-Achse in Spektrum 01 und 02 stellen auf: Scale als first profile „Wie das erste Spektrum“ und 

speichern: 

 

➔ Profile Properties  
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Kalibrierung eines 200L/mm-DADOS-Spektrums des Sterns Sirius A ( CMa, A1V) 

mit der Energiesparlampe ESL Megaman/Ormalight 

 

Zur Ermittlung der Instrumentenfunktion („Response“) werden beide Spektren nun durcheinander dividiert: 

 

➔ Perform this operation: Divide Profiles 

 On this Profile: 01: Sirius.fit 

 Using this profile: 03 A0V Reference Spectrum 

  

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Divisionsergebnis: 04 Divide Profile Sirius.fit by A0V Reference Spectrum 
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Kalibrierung eines 200L/mm-DADOS-Spektrums des Sterns Sirius A ( CMa, A1V) 

mit der Energiesparlampe ESL Megaman/Ormalight 

 

04 Divide Profile Sirius.fit by A0V Reference Spectrum muss aktiv sein. 

 
 

Nun wird das Divisionsergebnis #04 geglättet mit einem Polynom. Wir benötigen nur den Kontinuumsverlauf. 

Falls im Folgenden dazu aufgefordert, wird das Spektrum gespeichert. 

 

➔ Continuum & Response Shaper:  

 

 

 

 

 

 

➔ Punkte setzen entlang des Kontinuums des 

Spektrums 04 Divide Profile Sirius.fit by A0V 

Reference Spectrum. Das berechnete Polynom 

mit den gesetzten Stützstellen ist hier in der 

Farbe Orange sichtbar. 
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Kalibrierung eines 200L/mm-DADOS-Spektrums des Sterns Sirius A ( CMa, A1V) 

mit der Energiesparlampe ESL Megaman/Ormalight 

 

➔ Save …. Save as response DAT file… 

 

➔ Save 

➔ Save as response DAT file …  

➔ response_flux.dat 

➔ close 

  

Die Datei response_flux.dat ist das geglättete Divisionsergebnis und stellt nun eine Korrektur dar, die wir auf 

das Spektrum von 01 Sirius anwenden müssen: 
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Kalibrierung eines 200L/mm-DADOS-Spektrums des Sterns Sirius A ( CMa, A1V) 

mit der Energiesparlampe ESL Megaman/Ormalight 

9.2.2 Flusskalibrierung mit Datei response_flux.dat 
 

Bildschirm aufräumen: Spektren Nr. 02 und Nr. 03 

ausblenden (Hide Profile from Chart): 

 

➔ Nr. 2 ausblenden: Hide Profile from Chart 

 

➔ Nr. 3 ausblenden: Hide Profile from Chart 

 

➔ Nr. 4 ausblenden: Hide Profile from Chart 

 

 

 

➔ Nr. 1 muss aktiviert sein 

 

➔ Profile Properties: 01 Sirius.fit 

➔ Response -> Response File: response_flux.dat öffnen 

➔ Apply 
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Kalibrierung eines 200L/mm-DADOS-Spektrums des Sterns Sirius A ( CMa, A1V) 

mit der Energiesparlampe ESL Megaman/Ormalight 

Ergebnis: Das eigene flusskalibrierte Siriusspektrum 

 

Profile properties: 01 Sirius 

Man kann nun hin- und herschalten zwischen:  

➔ Profile properties: 01 Sirius 

➔ No Response Correction (unkalibriertes Siriusspektrum) 

➔ Response File (flusskalibriert, Flux) 

➔ Continuum Removal (Normierung) 

➔ Speichere Spektrum mit Response File 
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Kalibrierung eines 200L/mm-DADOS-Spektrums des Sterns Sirius A ( CMa, A1V) 

mit der Energiesparlampe ESL Megaman/Ormalight 

9.2.3 Speichern: Projekt – Profil – Chart – Image Strips 
 

➔ Save Project File 

 

Hinweis: Falls eine andere Speicheraufforderung kommt, bitte erst mit Diskettensymbol  speichern: 

Normierung des Spektrums im Bereich 5500Å bis 5550Å 
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Kalibrierung eines 200L/mm-DADOS-Spektrums des Sterns Sirius A ( CMa, A1V) 

mit der Energiesparlampe ESL Megaman/Ormalight 

Ergebnis: Flusskalibriertes Spektrum von Sirius 

 

Skalierung der Y-Achse von 0 bis 3: 

➔ Profile Properties 01: Sirius 

➔ Y-Axis 

➔ Manual Scaling 0 bis 3 

➔ Apply 

➔ Ok 

 

 

 

 

 

➔ Speichern: 
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Kalibrierung eines 200L/mm-DADOS-Spektrums des Sterns Sirius A ( CMa, A1V) 

mit der Energiesparlampe ESL Megaman/Ormalight 

9.2.4 Beschriftung des flusskalibrierten Spektrums 
 

➔ Add Label to chart   -> Manage Labels -> Load Set 

 

➔ Labelset Sirius A1V.lbl öffnen 

 

 

Das vorhandene Labelset war ausgerichtet auf das normierte Spektrum. Wir richten es neu aus und speichern 

es separat nur für das flusskalibrierte Spektrum ab. 

 

 

 

 

Die Einträge in diesem Labelset sind editierbar! Man kann weitere Einträge vornehmen. 

 

 

 

 

 

 

 

 

 

 

 

➔ Save Set:  

➔ Labelset Sirius A1V flusskalibriert.lbl 
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Kalibrierung eines 200L/mm-DADOS-Spektrums des Sterns Sirius A ( CMa, A1V) 
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Kalibrierung eines 200L/mm-DADOS-Spektrums des Sterns Sirius A ( CMa, A1V) 

mit der Energiesparlampe ESL Megaman/Ormalight 

9.2.5 Abspeichern des beschrifteten Spektrums (Save Chart to file) 
 

➔ Chart 

➔ Save Chart to file 

 

Vorsicht: Dateiendung png oder jpg, ABER NICHT .bass 

 

 

➔ Rechte Maustaste: Show Notes here (an gewünschte Stelle setzen) 
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Kalibrierung eines 200L/mm-DADOS-Spektrums des Sterns Sirius A ( CMa, A1V) 

mit der Energiesparlampe ESL Megaman/Ormalight 

  

➔
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Kalibrierung eines 200L/mm-DADOS-Spektrums des Sterns Sirius A ( CMa, A1V) 

mit der Energiesparlampe ESL Megaman/Ormalight 

9.2.6 Anpassung einer Planckschen Strahlungskurve 
 

Sirius, genauer Sirius A, hat eine Oberflächentemperatur von 9900K +/-200K1 

➔ Add a Planck temperature curve  

Die Wellenlänge ist die Lage des Strahlungsmaximums gemäß dem Wienschen Verschiebungsgesetz. „Height“ 

und „Offset“ sind willkürliche Parameter für die relative Anpassung, die niemals optimal gelingen kann: Sterne 

sind keine perfekten Schwarzen Strahler. 

 

 

 

 

 

 

 

 

 

 

 

 

 
1 https://www.aanda.org/articles/aa/pdf/2003/35/aa3846.pdf 
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Kalibrierung eines 200L/mm-DADOS-Spektrums des Sterns Sirius A ( CMa, A1V) 

mit der Energiesparlampe ESL Megaman/Ormalight 

10. Übertragung des Projekts an einem anderen Ort („Bundles“) 
 

BASS arbeitet projektbezogen. Das bedeutet, dass alle für das Projekt benötigten oder erstellten Dateien einen 

festen Pfad besitzen und in einem festen Ordner, hier C:/astrobodger/ … vorhanden sein müssen. Deshalb 

findet die Kalibrierung gemäß Tutorial ausschließlich im Ordner c:/astrobodger/Sirius_ESL statt.   

Frage: Wie überträgt man die ursprüngliche Kalibrierung .bass von C:/astrobodger/ … auf eine andere 

Festplatte und/oder in einen anderen Ordner, um sie von dort aus aufrufen zu können?  

Antwort: Man öffnet wie gewohnt in C:/astrobodger/Sirius_ESL die BASS-Datei (Beispiel: 

Sirius_flusskalibriert.bass und speichert das Projekt im neuen Ordner wie folgt als „Bundle“ ab: 

 

Speichern als Bundle:  

➔ File 

➔ Save Project or Bundle 

➔ D:/…./Sirius_flusskalibriert.bun 

 

 

 

 

 

 

 

 

 

 

 

Entpacken des Bundles am neuen Ort  

➔ File 

➔ Open Project or Bundle 

➔ D:/…./Sirius_flusskalibriert.bun 

Dort öffnet man die .bass-Datei des Projekts und arbeitet wie gewohnt weiter. 
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Kalibrierung eines 200L/mm-DADOS-Spektrums des Sterns Sirius A ( CMa, A1V) 

mit der Energiesparlampe ESL Megaman/Ormalight 

11. Kurse zur Sternspektroskopie am CFG Wuppertal 
Das Tutorials zur Kalibrierung eines Sonne-, bzw. 

Sternspektrums werden in den Kursen des Autors 

(rechts im Bild) am Carl-Fuhlrott-Gymnasium in 

Wuppertal zur Sternspektroskopie eingesetzt. Im 

Rahmen des Kurses wird u.a. das 

Tageslichtspektrum mit insgesamt sieben zur 

Verfügung stehenden DADOS-Spektrografen und 

ebenso vielen STF-8300M CCD-Kameras aufgenom-

men und für die Kalibrierung mit BASS vorbereitet.  

Die seit 2011 verwendete Software VisualSpec wird 

nur noch hin- und wieder herangezogen.  

Aktuelle Kursinformationen finden Sie unter:  

https://www.baader-planetarium.com/de/blog/aktuelle-spektroskopie-kurse-am-schuelerlabor-astronomie/ 
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